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NEW QUESTION 1
- (Topic 3)
A user is complaining that they are seeing a blank page, when they click Create New, from your custom Inventory application. You have confirmed that they can
see the Inventory application, and the Create New module on the application navigator. What could be the cause of this issue?

A. Create New module has a broken link
B. Known intermittent issue with U115
C. User should be using Chrome instead of Explorer for their browser
D. User has read role, but not the write role on the Inventory table
E. User session has timed out

Answer: D

NEW QUESTION 2
- (Topic 3)
Which feature helps to automatically allocate a critical, high priority, service request to the appropriate assignment group or team member?

A. User Policy
B. UI policy
C. Predictive Intelligence
D. Assignment Rule

Answer: D

NEW QUESTION 3
- (Topic 3)

Which path would you take to access the table configuration page from a form?

A. The Form Context menu > View > Table
B. The Form Context menu > Configure > Table
C. The Form Context menu > Configure > Dictionary
D. The Form Context menu > View > Show Table

Answer: B

NEW QUESTION 4
- (Topic 3)
When building an extended table from a base table, which fields do you need to create? Choose 2 answers

A. The mandatory fields for the base table.
B. The reference fields for the base table.
C. The fields that are not in the base table.
D. The fields that are specific to the extended table.

Answer: CD
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NEW QUESTION 5
- (Topic 3)
From a related list, what would a user click for personalize the layout of the columns?

A. Magnifier
B. Context Menu
C. Pencil
D. Gear

Answer: D

NEW QUESTION 6
- (Topic 3)
Which role can manage multiple knowledge bases?

A. knowledge_base_admin
B. kb_admin
C. sn_kb_admin
D. knowledge_admin

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/knowledge-management/reference/r_KnowledgeRoles.html

NEW QUESTION 7
- (Topic 3)
Which type of scripts nun in the browser?

A. Script include Scripts
B. Business Rule Scripts
C. Access Contra! Scripts
D. Ul Policies and Client Scripts

Answer: D

NEW QUESTION 8
- (Topic 3)
Which field (or fields) is used as a unique key during imports?

A. Match Fields
B. Coalesce Fields
C. Key Fields
D. Sys IDs

Answer: B

Explanation: 
Reference: https://developer.servicenow.com/dev.do#!/learn/learning-plans/quebec/new_to_servicenow/app_store_learnv2_importingdata_quebec_coalescing

NEW QUESTION 9
- (Topic 3)
What are advantages of using Flow Designer? (Choose three.)

A. Supports advanced developers
B. Enables complicated scripting
C. Reduces technical debt
D. Less manual scripting
E. Smooth integration with 3rd party systems

Answer: CDE

NEW QUESTION 10
- (Topic 3)
A colleague wants to rearrange the columns on their My Work list. Once the user has navigated to the list where should they navigate to select and arrange the
columns?

A. Click Personalize List
B. Right click on any column heade
C. Context Menu > Configure > List Layout
D. Click List Context Menu > Personalize List
E. Click List Content Menu > Configure > List Layout

Answer: B

Explanation: 
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 To rearrange the columns on a list, users can right click on any column header and select Configure > List Layout from the context menu2. This will open a dialog
box where users can select the available fields and move them to the selected list using the arrow buttons2. Users can also drag and drop the fields to change the
order of the columns2.
References
? How To Configure List and Form Layouts | by ServiceNow Scholar - Medium2

NEW QUESTION 10
- (Topic 3)
The customer has asked that your change the default layout of the task list.
* Number
* Task Type
* Parent
* Short Description
* Assignment Group
* Assignment
* Updated
After navigation to the list, where would you click, to meet this requirement?

A. Right click on any column header, Context menu > Configure > List Layout
B. Right click List Gear icon > Configure > Columns
C. Click List Context Menu >Personalize List
D. Click List Context Menu > Configure Columns

Answer: B

NEW QUESTION 14
- (Topic 3)
On what part of the ServiceNow instance, would you find the option to access applications, like Incident Management?

A. Self Service Module
B. Application Navigator
C. Service Desk Homepage
D. Favorites

Answer: B

NEW QUESTION 15
- (Topic 3)
Here is an example of the criteria set for a knowledge base:
* Companies: ACME North America
* Department: HR
* Groups: ACME Manager
* Match All: Yes
In this example, what users would have access to this knowledge base?

A. Members of the ACME manager group, who are also members of HR Department and part of the ACME North America
B. Employees of ACME North America, who are members of HR Department or the ACME Manager group
C. Users which are members of either ACME North America, or HR Department, or ACME Manager Group
D. Member of the ACME Manager group, and HR department, regardless of geography

Answer: A

NEW QUESTION 17
- (Topic 3)
On the Cl Dependency View, what enables you to trace from an infrastructure item, like a Server, to the Services that are dependent on that Server?

A. Service Tracer
B. Automapping Utility
C. Relationships
D. Transform Map

Answer: C

NEW QUESTION 19
- (Topic 3)
For your implementation, the following tables. are extended fram each ofher:
* Incident table is extended from Task table.
* Super Incident table is extended from Incident table,
In this situation, which table(s) are P arent, Child and Base tables? Choose 5 answers

A. Incident table is a Base table
B. Incident table i
C. a Parent table
D. Incident table is a Child table
E. Super Incident table is a Child table
F. Super Incident table is a Parent table
G. Super Incident table is a Base table
H. Task table is a Base table
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I. Task table is a Parent table
J. Task table is a Child table

Answer: BCDGH

NEW QUESTION 22
- (Topic 3)
What are the main components of the Form Design interface? (Choose three.)

A. Field Layout
B. Page Header
C. Field Navigator
D. Field Picker
E. Form Layout

Answer: BCE

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/form-administration/concept/c_FormDesign.html

NEW QUESTION 24
- (Topic 3)
When using Flow Designer what is the Flow Execution initiated by?

A. A trigger
B. An existing subflow
C. Allow logic
D. An execution data pill

Answer: A

Explanation: 
 A trigger is an activity that, once specified, automatically initiates a flow1. A trigger specifies the conditions that start running the flow, such as creating a record in
a specified table, receiving an inbound email, or reaching an SLA target1.
References
? Flow trigger types - Product Documentation: San Diego - ServiceNow1

NEW QUESTION 28
- (Topic 3)
When you set a policy that is applied to all data entered into the platform (UI, Import Sets, or Web Services), where does this policy run by default?

A. Client
B. Server
C. Browser
D. Network

Answer: B

NEW QUESTION 31
- (Topic 3)
Your customer requires that they be able to monitor which users are performing impersonations in their instance. What would you do to meet that requirement?

A. Add the role Log Write [sn_log_write] to the Impersonator Group
B. Create user update set for impersonation tracking
C. Activate the glide.sys.log_impersonation prop
D. From User icon, select Elevate Roles
E. On the Impersonator role record, right click and select Create Log

Answer: C

Explanation: 
 Reference https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0717055

NEW QUESTION 33
- (Topic 3)
A subject matter expert routinely receives tasks which have been worked by first level support, before receiving the assignment
What could you suggest. to make it easier for the expert to read only the work notes in the Activity log?

A. Click Context menu > Work Notes View
B. Click Personalize icon and select Activity Stream
C. Right click form header > Form Layout > Add Work Notes Section
D. Click Funnel icon and select only work notes
E. Click Context menu > History

Answer: D
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NEW QUESTION 34
- (Topic 3)
What are the three key tables in an enterprise CMDB? Choose 3 answers.

A. omadb_rel_ci
B. sn_emdb
C. sn_emdb_ci
D. Ey omdb
E. sn_emdb_bak
F. omdb_ci
G. emdb_bak

Answer: ADF

NEW QUESTION 37
- (Topic 3)
When adding a related list to a form, you choose the related list from the list callector, What is an example of a related list you might see on the list collector?
Choose 3 answers:

A. Release Phase==Parent
B. Catalog Task->Parent
C. HR Case-=Parent
D. Problem==Parent
E. Outage->Task number

Answer: BCE

NEW QUESTION 38
- (Topic 3)
What is the result of the order in which access controls are evaluated?

A. Ensures user has access to the fields in a table, before considering their access to the table
B. Ensures user can get to work as quickly as possible
C. Ensures user has access to the application, before evaluating access to a module within the application
D. Ensures user has access to a table, before evaluating access to a field in the table

Answer: D

Explanation: 
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0541355

NEW QUESTION 40
- (Topic 3)
When importing spreadsheet data into ServiceNow, in which step does the data get written to the receiving table?

A. Run Transform
B. Run Import
C. Import Dataset
D. Execute Transform
E. Schedule Transform

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/paris-platform-administration/page/script/server-scripting/task/t_CreatingAFieldMap.html

NEW QUESTION 41
- (Topic 3)
What access does a user need to be able to import articles to a knowledge base?

A. sn_knowledge_import
B. sn_knowledge contribute
C. Can contribute
D. Can import

Answer: C

NEW QUESTION 43
- (Topic 3)
Which component of a table contains a piece of data for one record?

A. Factor
B. Field
C. Datapoint
D. Element
E. Item

Answer: 
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B

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/managing-data/concept/c_DataDictionaryTables.html

NEW QUESTION 47
- (Topic 3)
Which set of steps is used to import spreadsheet data into a ServiceNow table?

A. Load Data, Create Transform Map, Run Transform
B. Select Import Set, Select Transform Map, Run Transform
C. Select Data Source, Schedule Transform
D. Define Data Source, Select Transform Map, Run Transform

Answer: A

Explanation: 
 These are the steps to import spreadsheet data into a ServiceNow table, as explained in the official documentation1 and the video tutorial2. The other options are
either incomplete or incorrect.
References1: Import a spreadsheet - Product Documentation: Utah - Now Support Portal2: How To Import Data Into ServiceNow - YouTube

NEW QUESTION 49
- (Topic 3)
Farm a form, what would you click, to modify the order of the fields on the form? Choose 2 answers

A. Context Menu > Configure > Form Layout
B. Context Menu > Form > Layout
C. Right click on header > Configure > Form Design
D. Context Menu > Configure > Form Designer
E. Right click on header > Configure > UX Dashboard

Answer: AC

NEW QUESTION 53
- (Topic 3)
What are advantages of using spokes for integrations? Choose 3 answers

A. Reduces the need for code
B. Features scale and control mechanisms
C. Free spokes are available in the ServiceNow Store
D. Ensures discoverability and reuse
E. Automated event management

Answer: ADE

NEW QUESTION 57
- (Topic 3)
What icon do you use to change the icon and color on a Favorite’?

A. Star
B. Triangle
C. Pencil
D. Clock

Answer: C

NEW QUESTION 62
- (Topic 3)
What is the best practice related to using the Default Update Set for moving customizations between instances?

A. Merge Default update sets before moving between instances
B. Submit Default update set to application repository
C. You should not use the Default Update sets for moving between instances
D. Keep Default update set to maximum of 20 records, for troubleshooting purposes

Answer: C

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-application-development/page/build/system-update-sets/reference/default-update-sets.html

NEW QUESTION 66
- (Topic 3)
If a user is on an Incident form and is alerted when they change the value of the Priority field, which type of script executes in the Platform?

A. A server script
B. A client script
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C. A fix script
D. A business rule

Answer: B

Explanation: 
 A client script is a script that runs on the client side, meaning in the user’s browser, and can manipulate the user interface or validate user input1. A client script
can be configured to run when a form is loaded, when a field value changes, or when a form is submitted2. In this case, the script runs when the Priority field value
changes and alerts the user.
ReferencesClient scriptsClient script types

NEW QUESTION 70
- (Topic 3)
The wait time for end users is based on the round-trip between the client and the server. What activities are included in the round-trips?

A. Request + Response
B. Save + Update
C. Write + Read
D. Submit + Query
E. Insert + Verify

Answer: A

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-application-development/page/script/client-scripts/concept/client-script-best-practices.html

NEW QUESTION 74
- (Topic 3)
A Service Catalog project will involve building 80 catalog items. For each of the catalog items, the following fields will be mandatory on the forms:
* Requested for
*Requested by
* Approving manager
* Delivery instructions
All of the other variables will be specific to the individual catalog item. What features would you use when designing the catalog item form?

A. Create one Variable Set for the four variables; then add that variable set to each of the 80 catalog items.
B. Create a Record Producer that contains the four fields: then add to the record producer related list on the Catalog files.
C. Create a Flow Designer Action, with Variable Set Data Pill; then apply flow to all of the 80 catalog items.
D. Create an Order Guide, which includes all variables: then copy and hide variables as needed.
E. Create a Variable Set Template: then apply to all of the catalog items.

Answer: A

NEW QUESTION 75
- (Topic 3)
Which best describes a field in a SeniceNow table?

A. A field is a table cell that stores data
B. A field is a table row
C. A field is an item that appears in a menu list
D. A field is a record in a table

Answer: C

NEW QUESTION 79
- (Topic 3)
Many actions are included with flow designer, what are some frequently used core actions? Choose 4 answers.

A. Wait for Condition
B. Ask for Approval
C. Create Record
D. Wait for Match
E. Look for Update
F. Look Up Record

Answer: BCDF

NEW QUESTION 80
- (Topic 3)
When managing tags, you can adjust who is able to see iL What are the visibility options? Choose 3 answers

A. Admins
B. Everyone
C. Groups and Users
D. Roles and Permissions
E. Me

Answer: BCE
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NEW QUESTION 81
- (Topic 3)
What instance resource allows you to access guided tours, information about actions, and instructions an how to use inputs and outputs in your flaw?

A. Community
B. Help Panel (question mark icon)
C. Docs
D. Wiki

Answer: B

NEW QUESTION 86
- (Topic 3)
Which ServiceNow utility provides a modern interactive graphical interface to visualize
configuration items and their relationship?

A. CSDM Schema
B. Business Service Map
C. Dependency View
D. CI Class Map

Answer: D

NEW QUESTION 88
- (Topic 3)
What is the primary objective of the Display Business Rule?

A. To monitor fields on a form, and provide feedback
B. To use a shared g_scratchpad object, which can be sent to the client, as part of the form
C. To set files to mandatory, hidden, and read-only
D. To define what happens on a form, when a particular fled changes

Answer: B

NEW QUESTION 93
- (Topic 3)
What type of query allows you to filter list data using normal words, instead of the condition builder?

A. Natural Language Query
B. Alexa Query
C. Machine Learning Query
D. Predictive Intelligence Query
E. Auto-suggest Query

Answer: A

NEW QUESTION 97
- (Topic 3)
What is used to determine user access to knowledge bases or a knowledge article?

A. sn_kb_read, sn_article_read
B. Privacy Settings
C. Read Access Flag
D. User Criteria

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/knowledge-management/concept/user-access-knowledge.html

NEW QUESTION 100
- (Topic 3)
On the knowledge base record, which tab would you use to define which users are able to write articles to the knowledge base?

A. Can Read
B. Can Write
C. Can Contribute
D. Can Author
E. Cannot Author

Answer: C

NEW QUESTION 104
- (Topic 3)
Which tab on the knowledge base record, would you use to identify the sets of users who are able to read articles in that knowledge base?
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A. Access List
B. Can Access
C. Accessible to
D. Can Read

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/knowledge-management/task/t_SelectUserCriteria.html

NEW QUESTION 107
- (Topic 2)
When creating a global custom table named “abc”, what is the table name that is automatically assigned by the platform?

A. snc_abc
B. abc
C. u_abc
D. sys_abc

Answer: C

NEW QUESTION 110
- (Topic 2)
What is the difference between a Ul Policy and Data Policy?

A. Data Policies run only after Ul Policies run successfully
B. Data Policies run regardless of how data is entered Into ServiceNow, while Ul Policies are used for form interactions
C. Data Policies can be converted into Ul Policies, but Ul Policies can not be converted into Data Policies
D. Data Policies run when data is entered through the form, by an Import Set or by web services, while Ul Policies are set only by web services

Answer: D

NEW QUESTION 111
- (Topic 2)
ServiceNow contains a resource which provides the following:
A standard and shared set of service related definitions across ServiceNow products and platform that will enable and support true service level reporting.
A CMDB framework across our products and platform that will enable and support multiple configuration strategies.
What resource do these statements describe?

A. Common Services Data Model (CSDM)
B. Information Technology Service Management (ITSM)
C. Configuration Management Database (CMDB)
D. Information Technology Infrastructure Library (ITIL)

Answer: A

Explanation: 
Reference: https://www.servicenow.com/content/dam/servicenow-assets/public/en-us/doc-type/resource-center/solution-brief/sbr-servicenow-common-service-data-
model.pdf

NEW QUESTION 114
- (Topic 2)
Which of the following is used to categorize, flag, and locate records?

A. Search
B. Favorites
C. Tags
D. Bookmarks

Answer: C

NEW QUESTION 118
- (Topic 2)
From a form, what would you click to add additional fields to the form? (Choose two.)

A. Context Menu > Form > Layout
B. Context Menu > Configure > Form Layout
C. Context Menu > Configure > Form Design
D. Right click on header > Add > Field
E. Context Menu > Form > Designer
F. Right click on header > Configure > UX Dashboard

Answer: BD

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-it-service-management/page/product/change-management/task/t_CreateCustomField.html
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NEW QUESTION 119
- (Topic 2)
What is a key difference between Reporting and Performance Analytics?

A. Performance Analytics contains snapshots of data taken over time; Reporting shows only the data as it is, at the moment the report is run.
B. Performance Analytics can show trends; Reports cannot.
C. Reports can be run on a scheduled basis; Performance Analytics cannot.
D. Performance Analytics data can be published to Dashboards; Reports cannot.
E. Performance Analytics shows KPIs; Reporting does not.

Answer: B

NEW QUESTION 121
- (Topic 2)
Which tool should be used to populate commonly used fields in a form?

A. Template
B. Reference Qualifier
C. Formatter
D. Assignment Rule

Answer: A

NEW QUESTION 122
- (Topic 2)
What are the three permission requirements that must evaluate to true for an access control rule to apply?
Choose 3 answers

A. Conditions
B. table.
C. Roles
D. Script
E. table."
F. table.none

Answer: CDE

NEW QUESTION 125
- (Topic 2)
IntegrationHub enables execution of third-party APIs as a part of a flow. These integrations are referred to as

A. an action
B. a spoke
C. a connection
D. an integration step

Answer: B

NEW QUESTION 130
- (Topic 2)
What field contains a record’s 32-character, unique identifier?

A. sn_rec_id
B. rec_id
C. u_id
D. sys_id
E. sn_gu_id
F. sn_sys_id
G. id

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/table-administration/concept/c_UniqueRecordIdentifier.html

NEW QUESTION 134
- (Topic 2)
Which module would you use to create a new automation of business logic such as approvals, tasks, and notifications?

A. Process Automation > Flow Designer
B. Process Automation > Flow Administration
C. Process Automation > Workflow Editor
D. Process Automation > Process Flow
E. Process Automation > Active Flows

Answer: A

Explanation: 
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Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/administer/process-automation-designer/concept/getting-started-process-
automation.html

NEW QUESTION 136
- (Topic 2)
New records, new groups, and modified configuration Items (Cls): what do they have in common?

A. They are included in an Update Set
B. They are not captured in an Update Set
C. They are customizations
D. They do not have anything in common

Answer: A

NEW QUESTION 139
- (Topic 2)
After finishing your work on High Security Settings, what do you do to return to normal admin security levels?

A. Select Normal role
B. Log out and back in
C. Use System Administration > Normal Security module
D. Select Global Update Set
E. End Impersonation

Answer: B

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/security/concept/c_HighSecuritySettings.html

NEW QUESTION 144
- (Topic 2)
Which one of the following statements is true?

A. When an incident form is saved, all the Work Notes field text is recorded to the Activity Log field
B. When an incident form is saved, the Work Notes field text is overwritten each time work is logged against the incident
C. When an incident form is saved, the impact field is calculated by adding the Prion:, and Urgency values
D. When an Incident form is saved, the Additional Comments field text is cleared and recorded to the Work Notes section

Answer: D

NEW QUESTION 147
- (Topic 2)
What is the name of the table relationship, where two or more tables are related in a bi- directional relationship, so that the related records are visible from both
tables in a related list?

A. Database View
B. Many to Many
C. One to Many
D. Extended

Answer: B

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/managing-data/concept/c_DataManagement.html

NEW QUESTION 150
- (Topic 2)
Which plugin allows users to install multiple applications, application-customizations. or plugins at once?

A. Application Integration and Plugin Delivery (A1PD) SpokeBatch Install
B. Continuous Integration and Continuous Delivery (CICD) SpokeBatch Install
C. Multiple Integration and Process Delivery (MIPD) SpokeBatch Install
D. Quick Integration and Multiple Delivery (QIMD) SpokeBatch Install

Answer: B

NEW QUESTION 152
- (Topic 2)
What type of field allows you to look up values from one other table?

A. Reference
B. Verity
C. Options
D. Selections
E. Dot walk
F. Lookup
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Answer: A

Explanation: 
Reference: https://support.microsoft.com/en-us/office/create-or-delete-a-lookup-field-87e84cbd-d60c-4473-8a98-
3e391c42f239#:~:text=A%20lookup%20field%20can%20display,order%20in%20the%20Orders%20table

NEW QUESTION 155
- (Topic 2)
Group records are stored in which table?

A. Group [sn_user_group]
B. Group [sys_user_group]
C. Group [s_sys_group]
D. Group [u_sys_group]

Answer: B

Explanation: 
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0832548

NEW QUESTION 158
- (Topic 2)
As an IT employee what interface would you use, if you wanted to browse internal IT documentation, like troubleshooting scripts and FAQs?

A. Knowledge
B. ServiceNow Wiki
C. Knowledge Now
D. SharePoint
E. Stack Overflow

Answer: A

Explanation: 
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0547260

NEW QUESTION 160
- (Topic 2)
What would NOT appear in the Application Navigator if “service” is typed into the filter field?

A. Configuration > Business Services
B. Self-Service > Knowledge
C. Service Portal > Widgets
D. Incident > Assigned to me

Answer: D

NEW QUESTION 161
- (Topic 2)
Which one of the following is an accurate list of changes that are captured in an Update Set?

A. Changes made to tables, forms, schedules, and client scripts
B. Changes made to tables, forms, views, and fields
C. Changes made to: tables, form
D. Business Rules, and data records
E. Changes made to: table
F. forms groups, and configuration items (Cls)

Answer: A

NEW QUESTION 165
- (Topic 2)
What are the components that make up a filter condition? (Choose three.)

A. Operator
B. Match Criteria
C. Value
D. Column
E. Field

Answer: ACE

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-lists/concept/c_Filters.html

NEW QUESTION 168
- (Topic 2)
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Where in Flow Designer can users access information about actions that are added to the flow?

A. Virtual Agent Help
B. Local Action Help
C. Help Panel
D. Flow Assistant

Answer: C

NEW QUESTION 170
- (Topic 2)
Your customer would like to create a new template to notify users who are affected by network outages at their site. Which module would you use to create a new
notification?

A. System Notification > Email > Notifications
B. Administration > Notification Overview
C. System Properties > Email > Settings
D. User Preferences > Email > Notifications
E. Click Gear > Notifications > New

Answer: A

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/administer/notification/task/t_CreateANotification.html

NEW QUESTION 171
- (Topic 2)
What do you need to do before you can use an Application-based trigger in your flow?

A. Activate application trigger spoke
B. Activate trigger security rules
C. Activate application spoke, and plug-ins as needed
D. Assign Application trigger role [sn_app_trigger_write] to SME
E. Activate application plugins only

Answer: B

NEW QUESTION 173
- (Topic 2)
Which certificate-based authentication methods can be enabled so that users can log into the Service Portal? (Select all that apply) Select 2 Answers from the
below options

A. Extended Validation Access (EVA)
B. Organization Verification Card (OVC)
C. Common Access Card (CAC)
D. Domain Authentication Card (DAC)
E. Personal Identify Verification (PIV)

Answer: CE

NEW QUESTION 174
- (Topic 2)
A user wants to create a set of filter conditions, where they want to show records which satisfy two conditions:
Incidents where the state is Closed
Incidents where Assignment Group is Network
After clicking the Funnel icon, what should the user do?

A. Define the first condition; click AND button; define second condition; click Run
B. Define the first condition; click AND button; define second condition; press enter
C. Define the first condition; click OR button; define second condition; press enter
D. Define the first condition; click > icon on breadcrumb, define second condition; click Run
E. Define the first condition; click > icon on breadcrumb, define second condition; press enter

Answer: A

NEW QUESTION 175
- (Topic 2)
A new Service Desk employee in Latin America complains that the create dates and times are incorrect on their Incident list. What would you suggest to fix this
issue?

A. Have them clear their cache.
B. Have them use the gear icon to set the employee’s time zone.
C. Recommend they use Chrome, instead of Explorer.
D. Use the system properties to correct the instance’s time zone.
E. Have them correct the time zone on their computer.

Answer: E
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Explanation: 
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0659171

NEW QUESTION 176
- (Topic 2)
When designing a flow, how do you reference data from a record, in that flow?

A. Drag the table icon onto the flow definition
B. Use the condition builder to specify the desired values
C. Specify the source table on the data pill related list
D. Drag the data pill onto the flow definition
E. Add the table reference using the slush bucket

Answer: D

Explanation: 
Reference: https://developer.servicenow.com/dev.do#!/learn/learning-plans/paris/citizen_developer/app_store_learnv2_flowdesigner_paris_using_flow_variables

NEW QUESTION 177
- (Topic 2)
Which of the following protects applications by identifying and restricting access to available files and data?

A. Application Configuration
B. Verbose Log
C. Access Control Rules
D. Application Scope

Answer: D

NEW QUESTION 178
- (Topic 1)
database live at the Data Center.

A. True
B. False

Answer: A

NEW QUESTION 181
- (Topic 2)
What is a role in ServiceNow?

A. A role is one record m the Role [sys_user_role] table
B. A role is one record in the Role Iuser_sys_role] table
C. A role is a persona used In Live Feed Chat
D. A role Is a set of modules for a particular application

Answer: A

NEW QUESTION 183
- (Topic 2)
Which tool is used for creating dependencies between configuration items in the CMDB?

A. CI Relationship Editor
B. CMDB Builder
C. CI Service Manager
D. Cl Class Manager

Answer: D

NEW QUESTION 187
- (Topic 2)
What function do you use to add buttons, links, and context menu items on forms and lists?

A. UI Policies
B. UI Settings
C. UI Actions
D. UI Config

Answer: C

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/list-administration/concept/c_UIActions.html

NEW QUESTION 188
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- (Topic 1)
The baseline Service Catalog homepage contains links to which of the following components?

A. Record Producers, Order Guides, and Catalog Items
B. Order Guides, Item Variables, and Workflows
C. Order Guides, Catalog Items, and Workflows
D. Record Producers, Order Guides, and Item Variables

Answer: A

NEW QUESTION 192
- (Topic 1)
ServiceNow is a single-instance, multiple tenant architecture?

A. True
B. False

Answer: B

NEW QUESTION 193
- (Topic 1)
What are the main UI component(s) of the ServiceNow Platform?

A. Banner Navigator
B. Banner Frame
C. Application Frame
D. Application Navigator
E. Content Menu
F. Content Frame

Answer: BDF

NEW QUESTION 195
- (Topic 1)
Which one of the following statements best describes the purpose of an Update Set?

A. An Update Set allows administrators to group a series of changes into a named set andthen move this set as a unit to other systems
B. By default, an Update Set includes customizations, Business Rules, and homepages
C. An Update Set is a group of customizations that is moved from Production to Development
D. By default, the changes included in an Update Set are visible only in the instance to which they are applied

Answer: A

NEW QUESTION 199
- (Topic 1)
Configuration will not affect what others see on their forms.

A. True
B. False

Answer: B

NEW QUESTION 204
- (Topic 1)
Where would you go in ServiceNow to order services and products offered by various departments?

A. Service Catalog
B. Self Service
C. Service Department
D. Customer Service

Answer: A

NEW QUESTION 209
- (Topic 1)
What are the 6 methods available for user authentication?

A. Local Database: The user name and password in their user record in the instance database.
B. Multifactor: The user name and password in the database and passcode sent to the user's mobile device that has Google Authenticator installed
C. LDAP: The user name and password are accessed via LDAP in the corporate directory, which has a matching user account in the database.
D. SAML 2.0: The user name and password configured in a SAML identity provider account, which has a matching user account in the database.
E. OAuth 2.0: The user name and password of OAuth identity provider, which has a matching user account in the database.
F. Digest Token: An encrypted digest of the user name and password in the user record.

Answer: ABCDEF
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NEW QUESTION 210
- (Topic 1)
Each knowledge bases can have unique lifecycle workflows, user criteria, category structures, and management assignments.

A. True
B. False

Answer: A

NEW QUESTION 213
- (Topic 1)
What is the difference between UI Policy and UI Action?

A. UI Action can make fields read-only, mandatory, or hidde
B. while UI Policy can make a save button visible for appropriate users.
C. UI Policy can make fields read-only, mandatory, or hidde
D. while UI Action can make a save button visible for appropriate users.

Answer: B

NEW QUESTION 216
- (Topic 1)
Which term best describes something that is created, has worked performed upon it, and is eventually moved to a state of closed?

A. report
B. workflow
C. event
D. task

Answer: D

NEW QUESTION 217
- (Topic 1)
Which type of interface enables you to display multiple performance analytics, reporting and other widgets on a single screen?

A. Form
B. List
C. Dashboard
D. Timeline

Answer: C

NEW QUESTION 221
- (Topic 1)
What is a formatter? Select one of the following.

A. A formatter allows you to configure applications on your instance
B. A formatter is a form element used to display information that is not a field in the record
C. A formatter allows you to populate fields automatically
D. A formatter is a set of conditions applied to a table to help find and work with data

Answer: B

NEW QUESTION 223
- (Topic 1)
Which application is used to change the number format per table?

A. Number Maintenance
B. System Maintenance
C. Table Maintenance
D. Record Maintenance

Answer: A

NEW QUESTION 226
- (Topic 1)
Which of the following is true of Service Catalog Items in relation to the Service Catalog?

A. They run behind the scenes.
B. They are the building blocks.
C. They are optional.
D. They provide options.

Answer: B
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NEW QUESTION 228
- (Topic 1)
In what order should filter elements be specified?

A. Field, Operator, then Value
B. Field, Operator, then Condition
C. Operator, Condition, then Value
D. Value, Operator, then Field

Answer: A

NEW QUESTION 232
- (Topic 1)
From the User menu, which actions can a user select? (Choose three.)

A. Send Notifications
B. Log Out ServiceNow
C. Elevate Roles
D. Impersonate Users
E. Order from Service Catalog
F. Approve Records

Answer: BCD

NEW QUESTION 233
- (Topic 1)
What defines conditions that are evaluated against users to determine which users can create, read, write, and retire knowledge articles.

A. User conditions
B. User info
C. User Criteria
D. User permissions

Answer: C

NEW QUESTION 238
- (Topic 1)
Which one of the following statements is a recommendation from ServiceNow about Update Sets?

A. Avoid using the Default Update set as an Update Set for moving customizations from instance to instance
B. Before moving customizations from instance to instance with Update Sets, ensure that both instances are different versions
C. Use the Baseline Update Set to store the contents of items after they are changed the first time
D. Once an Update Set is closed as “Complete”, change it back to “In Progress” until it is applied to another instance

Answer: A

NEW QUESTION 242
- (Topic 1)
Knowledge Base Search results can be sorted by which of the following? (Choose three.)

A. Most recent update
B. Popularity
C. Relevancy
D. Manager assignment
E. Number of views

Answer: ACE

NEW QUESTION 244
- (Topic 1)
Where can Admins check which release is running on an ServiceNow instance?

A. Memory Stats module
B. Stats module
C. System.upgraded table
D. Transactions log

Answer: B

NEW QUESTION 245
- (Topic 1)
What is the function of user impersonation?

A. Testing and visibility
B. Activate verbose logging
C. View custom perspectives
D. Unlock Application master list
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Answer: A

NEW QUESTION 247
- (Topic 1)
For Administrators creating new Service Catalog items, what is a characteristic they should know about Service Catalog variables?

A. Service Catalog variables can only be used in Record Producers
B. Service Catalog variables can only be used in Order Guides
C. Service Catalog variables cannot affect the order price
D. Service Catalog variables are global by default

Answer: D

NEW QUESTION 250
- (Topic 1)
Access Control rules may be defined with which of the following permission requirements? (Choose three.)

A. Roles
B. Conditional Expressions
C. Assignment Rules
D. Scripts
E. User Criteria
F. Groups

Answer: ABD

NEW QUESTION 255
- (Topic 1)
What is the purpose of a Related List?

A. To create a one-to-many relationship
B. To dot-walk to a core table
C. To present related fields
D. To present related records

Answer: D

NEW QUESTION 259
- (Topic 1)
What are the two aspects to LDAP Integration?

A. Data Population
B. Data formatting
C. Authorization
D. Authentication

Answer: AD

NEW QUESTION 260
- (Topic 1)
What are the three components of a filter condition?

A. Table
B. Value
C. Field
D. Operator

Answer: BCD

NEW QUESTION 261
- (Topic 3)
What process allows users to create, categorize, review approve and browse important information in a centralized location that is shared oy the entire
organization?

A. Self Service Management
B. Knowledge Management
C. Knowledge-Centered Management
D. Information Portal Management
E. Business Information Management

Answer: B

Explanation: 
 Knowledge Management is the process that allows users to create, categorize, review, approve and browse important information in a centralized location that is
shared by the entire organization1. Knowledge Management helps users to find relevant and accurate information quickly, reduce the need to rediscover
knowledge, and improve the quality of service and customer satisfaction1.
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References
? Knowledge Management - ServiceNow1

NEW QUESTION 262
- (Topic 3)
Which is the base table of the configuration management database hierarchy?

A. cmdb_d
B. ucmdb
C. cmdb_ret_Oi
D. cmdb

Answer: D

NEW QUESTION 264
- (Topic 3)
What actions are taken to filter a long list of records to show only those with the Category of Hardware?

A. On Breadcrumb, click the > icon, type Hardware and click enter
B. On the Category column header, right-click and select Show > Hardware
C. On the list, locate and right-click on the value Hardware, select Show Matching
D. Right-click on magnifier type Hardware and click enter
E. Click Funnel icon, type Hardware and click enter

Answer: C

NEW QUESTION 268
- (Topic 3)
What table acts as a staging area for records imported from a data source?

A. Transform Table
B. Staging Table
C. Import Set Row Table
D. Temp Table

Answer: C

NEW QUESTION 270
- (Topic 3)
Which is the most efficient way to move large amounts of data between instances?

A. Export to Data Package
B. Export to XML
C. Update Sets
D. Export to Zip

Answer: B

NEW QUESTION 271
- (Topic 3)
Which helps to visualize configuration items and their relationships?

A. Transform Map
B. Schema Map
C. Tables
D. Flow Design
E. Dependency View

Answer: E

Explanation: 
The Dependency View provides a visual representation of the relationships between configuration items (CIs) in ServiceNow. It allows you to see how CIs are
connected and how changes to one CI may impact others.
References:
? ServiceNow Product Documentation: Configuration item relationships in the CMDB
- https://docs.servicenow.com/bundle/vancouver-servicenow- platform/page/product/configuration-management/concept/c_CIRelationships.html
? ServiceNow Community: How to display dependencies for CIs in the Dependency
View - https://www.servicenow.com/community/service-management-forum/load- a-specific-dependency-view-map/m-p/410421

NEW QUESTION 274
- (Topic 3)
While on an Incident record, how would you add a Tag for "Special Handling" to the record?

A. Click on the More options (.,.) icon, click Add Tag, type Special Handling, press enter
B. On the Special Handling field, check the box
C. On the Tag field, select Special Handling from the choice list
D. Click on the Context menu, select Add Tag, type Special Handling, press enter
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Answer: A

NEW QUESTION 278
- (Topic 3)
When creating a new notification, what must you define? Choose 3 answers

A. What is the content of the notification
B. The associated knowledge base
C. Under what conditions is the notification sent
D. Who receives the notification
E. Settings for handling inactive user accounts

Answer: ACD

NEW QUESTION 281
- (Topic 3)
When looking at a long list of records, you want to quickly filler, to show only those which have Shon Description containing email
How might you do that?

A. Click List Magnifier to expand column search, on Short Description, type “email, click enter
B. Click List Magnifier to expand column search, on Short Description, lype *email, click enter
C. Click List Magnifier to expand column search, on Short Description, type email, click enter
D. On Search box, select text, type email, click enter

Answer: A

NEW QUESTION 286
- (Topic 3)
What module do you use to access the reports that are available to you?

A. Report > View /Run
B. Reports > Homepage
C. Self-Service>My Reports
D. Report > Overview

Answer: B

NEW QUESTION 291
- (Topic 3)
When looking at a long list of records, you want to quickly filter, to show only those which have Category of Hardware. How might you do that?

A. On the Iist, locate and right click on the value Hardware, select Show Matching
B. Click Funnel ten, type Hardware and click enter
C. On the Category column header, right click and select Show > Hardware
D. Right dick on magnifier, type Hardware and click enter
E. On Breadcrumb, click > icon, type Hardware and click enter

Answer: A

NEW QUESTION 293
- (Topic 3)
An IT user calls the service desk because his work needs to be completed on ask records. All he can see a Self Service on his homepage when he logs in to the
ServiceNow instance. What issue could explain this?
Choose 2 answers

A. His user account failed LDAP authentication
B. His user account does not Belong to any groups, which contain the ITIL role
C. His user account was not approved by his manager
D. His user account does not have ITIL role
E. His user account Is not logged in properly

Answer: BE

NEW QUESTION 294
- (Topic 3)
What resource can you use to view details of the tables and configuration items (CIs) associated with a particular use case?

A. Scenario Dashboard
B. CI Use Case Modeler
C. CMDB Use Case Modeler
D. Common Service Data Model (CSDM) product view

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/quebec-servicenow-platform/page/product/csdm-implementation/reference/cmdb-use-case.html
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NEW QUESTION 297
- (Topic 3)
What component causes a flow to run after a record has been created or updated?

A. Date-based trigger
B. Record-based trigger
C. On-change trigger
D. Application-based trigger
E. Updated-date trigger

Answer: B

Explanation: 
A record-based trigger is a component that causes a flow to run after a record has been created or updated in a specified table1. It allows users to define
conditions and actions for the flow based on the record’s state and values1. For example, a record-based trigger can start a flow when a new incident is created or
when an existing incident is updated with a certain priority1.
References
? Flow trigger types - Product Documentation: San Diego - ServiceNow1

NEW QUESTION 301
- (Topic 3)
Which allows the creation of a task-based record from Service Catalog?

A. Record Producers
B. UI Builder
C. Assignment Rule
D. Flow Designer
E. UI Actions=

Answer: D

NEW QUESTION 304
- (Topic 3)
How would you distinguish between a Base Class table and a Parent Class table?

A. Base Class tables always have tables extended from them, Parent tables do not have tables extended from them.
B. Base Class table is not extended from another tabl
C. Parent class tables may be extended from another table.
D. Extended tables can be extended from Parent tables or Base tables, but they cannot be extended from both.
E. Extended tables are always extended from Parent tables, Extended tables are usually extended from Base tables,

Answer: B

NEW QUESTION 305
- (Topic 3)
On a filter condition, which component is always a choice list?

A. Operator
B. Filter Criteria
C. Operation
D. Match Criteria

Answer: C

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/common-ui-elements/concept/c_ConditionBuilder.html

NEW QUESTION 306
- (Topic 3)
If a knowledge base has no access details specified, what users are able to read articles in that knowledge base?

A. itil users
B. Any user with an article's permalink
C. Any active user
D. No users
E. Users with kb_user role

Answer: C

Explanation: 
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0623654

NEW QUESTION 307
- (Topic 3)
The Report Designer contains different sections for configuring your report. Which section is used to adjust the look of your report, including colors, files, and
legend layout?
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A. Format
B. Layout
C. Style
D. Configure

Answer: C

NEW QUESTION 310
- (Topic 3)
On a filter condition, there is an element, which is based on the table, the user access rights, and columns on the table. What is this element called?

A. Attribute
B. Label
C. Field
D. Column
E. Data Element

Answer: C

NEW QUESTION 315
- (Topic 3)
What are benefits of assigning work tasks to a group, rather than to an individual? (Choose four.)

A. Group members can choose their tasks from My Groups Work
B. Groups can assign tasks to users based on on-call schedules
C. Site support members can pick tasks, based on Location
D. Groups can assign tasks to users based on skills
E. Group members can avoid tasks, which are nearing SLA breach
F. Groups can assign tasks to users based on availability

Answer: BCDF

NEW QUESTION 316
- (Topic 3)
When moving a homepage or dashboard between instances, what must you remember?

A. Create a separate update set for them
B. They are automatically added to the update set
C. Manually add them to the update set
D. They cannot be moved via update set

Answer: C

NEW QUESTION 320
......
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